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Filezilla Configuration (English)

Start FileZilla
Find and double click the icon as seen in Figure 1

fz

FileZilla
Client

Figure 1

Site Manager

To Open Site Manager When You Launch FileZilla
1. Click on the “Edit” menu item
2. Select “Settings” (Figure 2)

[ FileZilla

File | Edit | View Transfer Server Bookmarks Help Mew version available!
iis Metwerk cenfiguration wizard... L | FTaoms
o] Clear private data... Daccword:

I— Sq‘tt}i‘ngs...

Figure 2




3. Inthe “Settings” window, under the “Interface” page check the box beside “Show the Site

Manager on startup” and click “OK”. (Figure 3)

Settings R
Select page: Passimids
=- Clcnnnecticnn (7 Save passwords
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Master password:
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=) Transfers
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Figure 3




Creating and Configuring Sites
The recommendation is to create two sites:

e One for the SAS Shared or common folders.
e One for the SAS Home folder.

Creating and configuring the SAS Shared site (or common folders)
1. Click on the “File” menu item
2. Select “Site Manager” (Figure 4)

FileZilla
Edit View Transfer Server Bookmarks Help MNew version available!
Site Manager... Ctrl+5 | Ak
Copy current connection to Site Manager... |
sword:
MNew tab Ctrl+T
Close tab Ctrl+W
Export...
Import...
Show files currently being edited... Ctrl+E
Exit Ctrl+Q
Figure 4

OR

Select the icon in figure just below the “File” menu item.

Figure 5




3. Click on the “New Site” button and type “SAS 9.4 Shared”. (Figure 6)
4. Onthe “General” tab, select the “Host” field and type “sinpappsas-04.hc-sc.gc.ca”. (Figure 7)
5. Click on the “Protocol” drop-down box and select “SFTP — SSH File Transfer Protocol”.
6. Click on the “Logon Type” drop-down box and select “Ask for password”.
7. Select the “User” field and type your username.
rSibe Manager ﬁ_‘
select Entry: General | Advanced | Transfer Settings | Charset
FTP - File Transfer Protocol
Use explicit FTP owver TLS if available
Anonymous
MNone
New Site S | New Folder i
Mew Bookmark Rename
Delete Duplicate -
Connect QK ] [ Cancel

Figure 6




~

Site Manager &
Select Entry: General |Advanced | Transfer Settings | Charset|
Iy Si
i !}r Host: |sinpappsas—ﬂ4.hc—sc.gc.ca | Port:
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Figure 7




To create and configure the home folder site:
1. Inthe “Select Entry” pane, select the “SAS 9.4 Shared” site and click on “Duplicate”.

2. Type “SAS 9.4 Home”.

3. Select the “Advanced” tab and type “/sasusers/USERNAME” where USERNAME is the username

of your SAS account — remember it’s case-sensitive. (Figure 8)

-
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Figure 8




To test the sites:

The “SAS 9.4 Shared” Site
1. Inthe “Select Entry” pane, select the “SAS 9.4 Shared” site and click on the “Connect” button.
Enter your Novell credentials (remember both your username and password are case-sensitive).

Ensure the box beside “Remember password until FileZilla is closed” is checked and click “OK".

(Figure 9)

-
Enter username and password 2

Please enter usernarne and password for this server
Mame: 5A59.4 Home
Host:  sindappsas-04.hc-sc.ge.ca

Lzer PERCOBIMNS

Password: sessssssss

Remember password until FileZilla is closed

| ok || Cancel

-

-
e T —__

Figure 9

4. If you are presented with the “Unknown host key” window, place a check mark in the box next
to “Always trust this host, add this key to the cache” and click “OK”. (Figure 10)

-

Trust this host and carry on connecting?

MD5: 23:chic3:23:41:42:1b:18: bed8:8 e:f3:58: ebifbicc

[/] Always trust this host, add this key to the cache

[ Unknown host key 2
The server's host key is unknown. You have no guarantee that the server is
the computer you think it is.
Details
Host: sinpappsas-04.he-sc.gc.cad
Hostkey algorithm: ssh-ed25519 256
Fingerprints: SHAZ25G: yZdjQF04RC+ GObO4nGwd of+ F2vQougtbk04 Ogsl+ qdA=

ok ||

Cancel

L

Figure 10




The “SAS 9.4 Home” Site
For the SAS 9.4 Home site, repeat the same steps as in The “SAS 9.4 Shared” Site, however in the “Select

Entry” pane choose “SAS 9.4 Home” and click “Connect”.

Navigating

On the left hand side of the window is your workstation folder structure (Local site). On the right hand
side is the SAS server directory structure (Remote site). (Figure 11)

-
SAS 9.4 Home - sftpi//PEROBINS@sindappsas-04.hc-scge.ca - FileZilla = = P
File Edit View Transfer Server Bookmarks Help MNew version available!
113 i~ = = 5
= EEFEOECRO XL Faes
Host: Username: Password: Port: B
Status: Connecting to sindappsas-04.hc-sc.ge.ca.., -
Status: Connected to sindappsas-04.hec-sc.ge.ca
Status: Retrieving directory listing of "/sasusers/PEROBINS"...
Status: Listing directory /sasusers/PEROBINS
Status: Directory listing of "/sasusers/PEROBINS" successful
| Local siter | C\Users\perobins\Documents', = | Remote site: | /sasusers/PEROBING -
Ea! De;ktgp ~ B ? f
[+ | Documents [ =l 2 sasusers
----- g Downloads - G- |, PEROBINS
1 | 1] | r
Filename Filesize Filetype Filename : Filesize Filetype Last modified -
| cache File folder . Isbatch File folder 2018-07-12 11:46:3
Figure 11

To upload a file from your workstation to the SAS server

1. Inthe left hand pane, navigate to the path with the file to upload (displayed in Local site).
2. On the right hand pane, select the path (directory) to which you want to upload the file
(displayed in Remote site).
3. Drag and drop the file from the left hand pane (Local site) to the right hand pane (Remote site)
4. The file will be uploaded to the path in the Remote site (right hand site).

To download a file from the SAS server to your workstation

1. Inthe right hand pane, navigate to the path with the file to download (displayed in Remote site).
2. Onthe left hand pane, select the path (directory) to which you want to download the file
(displayed in Local site).
3. Drag and drop the file from the right hand pane (Remote site) to the left hand pane (Local site)
4. The file will be downloaded to the path in the Local site (left hand site).




To disconnect from the remote site

Click on the icon seen in Figure 12

indappsas-04.hc-sc.ge.ca - FileZilla

Bookmarks

t Q|

Help  Mew version available!

| FTAaos

[ Disconnects from the currently visible server

Figure 12

OR

Click on the “Server” menu item and select “Disconnect” (Figure 13).

Figure 13

Port

praper protocol,

File Edit View Transfer E-Sewer] Bookmarks Help

j-_;_;L b4 | Eﬁia Cancel current operation Ctrl+.
Hast: 1 Reconnect Ctrl+R
Status: Selected port Diconedt I:} L0
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Status: Connection Enter custom command...

Response: 35H-20-Ope Force showing hidden files

Errar: Cannot estall

Errorn: Critical error: Could not connect to server



Configuration Filezilla (Francais)

Démarrez Filezilla
Trouvez et sélectionnez I'icéne sur votre bureau tel qu’indique dans Figure 14

fz

FileZilla
Client

Figure 14

Gestionnaire de sites

Pour ouvrir le gestionnaire de sites apres avoir démarré Filezilla
1. Sélectionnez « Edition »
2. Sélectionnez « Paramétres... » (Figure 15)

.
FileZila (U

Fichier | Edition | Affichage Transfert Serveur Favoris 7

3 : : : : T

Sl ¥ | Assistant de configuration réseau... € P o)
ol Supprimer les données personnelles...

Hite: Mot de passe :

Parameétres... h

Figure 15




3. Dans la fenétre « Paramétres de Filezilla », sous la branche “Interface”, placez un crochet pour
« Afficher le Gestionnaire de Sites au Démarrage de Filezilla » et assurez-vous de ne pas
sauvegarder les mots de passe. Sélectionnez « OK » (Figure 16).

i ™y
Paramétres de FileZilla — - — e
Sélectionnez une page: Mots de passe
=- C_unnexicm (2) Sauvegarder les mots de passe
=-FTP [G Ne pas sauvegarder les mots de passe
Mode actif () Sauvegarder les mots de passe protégés par un mot de passe principal
Mode passif it s
- iy ETP ot de passe principal :
SFTP Confirmer le mot de passe:
‘... Proxy générique
5 ¢ L'oubli du mot de passe principal est irrécupérable ! Veillez & bien mémaoriser votre mot de passe.
= Transferts
L. FTP : Types de fichiers Agencement
L. Action lorsque le fichier existe Disposition des arborescences des fichiers et dossiers :
E'" [7] Permuter les volets des arborescences locale et distante
Themes
Format de Date et Heure Journal des événements
Format de |a taille des fichiers Position du journal des événements : | Au-dessus de Ia liste des fichiers
i Listes des fichiers
- Langue Comportement
=g E:diti':'” des fichiers [7] Minimiser dans la zone de notification
= Clesictiog: oy de liciiey Empécher la mise en veille de 'ordinateur pendant les transferts et toutes autres opérations
B al_|cn.!r [ Afficher le Gestionnaire de Sites au démarrage de FileZilla }
- Journalisation - - - i
g Lors du démarrage d'une nouvelle connexion tout en étant déja connecté :
- Débogage
i [Demander I'action a effectuer -
[ OK J File d'attente
[ [T] Afficher temporairement le taux de transfert 4 la place du taux moyen
Annuler l

Figure 16




Création et configuration de sites
La recommandation est de créer et configurer deux sites:

e Un site pour le répertoire partagé SAS ou répertoires communs

e Un site pour le répertoire maison SAS.

Création et configuration du site pour répertoire partagé/commun

1. Sélectionnez « Fichier » (Figure 17)

2. Sélectionnez « Gestionnaire de Sites... » (Figure 17) ou sélectionnez I'icone sous « Fichier »

(Figure 18)

I3 Filezilla -

Fichier | Edition Affichage Transfert Serveur Favaris 7

Gestionnaire de Sites.., Ctrl+5
Ajouter la connexion actuelle%ms le Gestionnaire de Sites..,
MNouvel onglet Ctrl+T
Fermer I'onglet Ctrl+W
Exporter les paramétres...
Importer les paramétres...
Afficher les fichiers en cours d'edition... Ctrl+E
Quitter Ctrl+Q
Figure 17
e
. .

Figure 18




3. Dans la fenétre Gestionaire de Sites, choisissez « Nouvean Site » et tapez “SAS 9.4 Shared”.

(Figure 19Error! Reference source not found.)

© N v e

Sélectionnez « OK »

Sélectionnez le champ « Identifiant » et tapez votre nom d’utilisateur (Figure 20)

-
Gestionnaire de Sites

===

Sélectionnez une entrée :

A sas
B sassa

Mouveau Favori Renomrmer

Supprimer Dupliquer

Mouveau Site %] ’ Mouveau Dossier

Géneral |A\rancé | Paramétres de transfert | Jeu de caractéres|

Hote : Fort

FTP - Protoceole de Transfert de Fichiers

Connexion FTP explicite sur TLS si disponible

! | Anonyme

Couleur de fond ! | Aucune

Connexion OK l [ Annuler

e

Figure 19

4

Sur I'onglet « General », sélectionnez le champ « Hote » et tapez “sinpappsas-04.hc-sc.gc.ca”.
Sélectionnez « SFTP — SSH File Transfer Protocol » du menu déroulant Protocole.
Sélectionnez « Demander le mot de passe » du menu déroulant « Type d’authentification ».



-

Gestionnaire de Sites

Sélectionnez une entrée :

Mes Sites

B | 5459.4 Shared

]

| ’ Mouveau Site ] [ Mouveau Dossier ]
| ’ Mouveau Favori ] [ Renommer ]
l Supprimer ] [ Dupliquer

Général |A1.far1cé | Paramétres de transfert | Jeu de caractéres|

Hate: sinpappsas-04.hc-sc.ge.ca

Protocole

SFTP - 55H File Transfer Protocol

Type d'authentification : [Demander le mot de passe -
Identifiant : ] BOESTINY
MDtdEpESSE: S0 SEBOBERIBRORERD
Couleur de fond :
Commentaires :
[ Connexion ] [ QK l [ Annuler

LS

Figure 20




Création et configuration du site pour répertoire maison (« SAS 9.4 Home »)
1. Dans le volet “Sélectionnez une entrée”, choisissez le site « SAS 9.4 Shared » et sélectionnez

« Dupliquer ».
2. Tapez « SAS 9.4 Home ».

Sélectionnez I'onglet « Avancé » et tapez “/sasusers/USERNAME” ou USERNAME est le nom
d’utilisateur de votre compte SAS — rappel qu’il est sensible a la casse. (Figure 21)

Gestionnaire de Sites

S

Sélectionnez une entrée :

Mes Sites

B sas
... M sassa

...... B 54594 Shared

| Général | Avance | Paramétres de transfert | Jeu de caractéres|

8 (S5 Fome |

Type de serveur: | Par défaut (Détection automatique) "']

[Tl Ignorer le Proxy

Dossier local par défaut:

Dossier distant par défaut

Ysasusers\BDESTINY

[ Mouveau Site I l Meouveau Dossier ]

| [ Mouveau Favori I l

| [ suppimer__] |

[T] Utiliser Ia navigation synchronisée

[] Cormparaison de dossier

Ajuster le décalage horaire du serveur :

0 = Heures, a

Parcourir...

Connexion ] [

OK ] [ Annuler

Figure 21




Vérifications des sites:

Le site « SAS 9.4 Shared »
1. Dans le volet « Sélectionnez une entrée », choisissez le site « SAS 9.4 Shared » et sélectionnez

« Connexion ».

2. Tapez vos identifiants Novell (rappel — votre nom d’utilisateur et votre mot de passe sont
sensible a la casse).

3. Assurez-vous que vous avez cocher la boite « Mémoriser le mot de passe jusqu’a la fermeture
de FileZilla » et sélectionnez « OK ». (Figure 22)

r ™y
Saisie de mot de passe Iﬁ

Saisissez un mot de passe pour ce serveur:
Mom : 5A59.4 Shared

Hote: sinpappsas-04.hc-sc.gc.ca
Identifiant : BDESTINW

Mot de passe: esssssssss

Meémariser le mot de passe jusqu'a la fermeture de FileZilla

| ok || Annler

L "

Figure 22

4. Siétes présenté avec la fenétre « Clé de I’"hote inconnue », placez un crochet dans la boite a
cote de « Toujours faire confiance a cet hote, ajouter cette clé au cache » et sélectionnez « OK ».
(Figure 23)
r !
- T - R —— e ———
Clé de I'héte inconnue ﬁ

La clé du serveur hdte est inconnue. Yous n'avez aucune garantie que ce
serveur est bien le bon.

Details

Hote : sinpappsas-04.hc-sc.ge.ca:22

Algorithme de la clé de I'héte : ssh-ed25519 256

Emnpreintes : SHAZ256: wZdjQFARC+GObOdnGwd oA+ F2vQouqtbk94 OgsU+qdA=

MD5: 23:chicdi2 34421 bl §:bed8:8 eif3:58: ebifhico

Approuver ce serveur et |'associer a la connexion 7

{Toujours faire confiance 3 cet hite, ajouter cette clé au r_achej

| ok || Annuer

L= 4

Figure 23




Le site « SAS 9.4 Home »
Pour le site « SAS 9.4 Home », répétez les mémes étapes que dans Le site « SAS 9.4 Shared », sauf dans

le volet « Sélectionnez une entrée », choisissez le site « SAS 9.4 Home » et sélectionnez « Connexion ».

Navigation

Sur le coté gauche de la fenétre vous allez voir la structure de vos dossiers sur votre systéme local (Site

local). Sur le coté droit est la structure des dossiers sur le serveur SAS (Site distant). (Figure 24)

ﬂ_ SAS 9.4 Shared - sftp://PEROBINS @sinpappsas-04.hc-sc.gc.ca - FileZilla
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2 @ File d'attente : vide

Figure 24

Pour transférer un fichier de votre systéme sur le serveur SAS

1. Dans le volet de gauche, naviguez au répertoire désiré (Il sera affiché sous « Site local »).
2. Choisissez le fichier désiré dans le volet avec les colonnes « Nom de fichier », « Taille de
fichier », « Type de fichier » et « Derniére modifications ».




3.

4.

Sur le volet droit, répétez étape 1, mais cette fois-ci, choisissez le répertoire auquel vous voulez
transférez votre fichier local. (Figure 24)
Glisser-déposer le fichier du volet du c6té gauche au volet du c6té droit.

Pour transférer un fichier du serveur SAS a votre systeme local

1.
2.

Dans le volet droit, naviguez au répertoire désiré (Il sera affiché sous « Site distant »).
Choisissez le fichier désiré dans le volet avec les colonnes « Nom de fichier », « Taille de
fichier », « Type de fichier », « Derniére modifications », « Droits d’accés » et « Propriétaire ».
Sur le volet gauche, répétez étape 1, mais cette fois-ci, choisissez le répertoire auquel vous
voulez transférez votre fichier de serveur. (Figure 24)

Glisser-déposer le fichier du volet du c6té droit au volet du c6té gauche.

Pour vous déconnecter du site distant

Pour vous déconnecter du site distant, sélectionnez I'icbne « Déconnecter du serveur actuellement
visible » (Figure 25)

%ll

LEaos

Déconnecter du serveur actuellernent visible }

Figure 25

ou

Sélectionnez le menu « Serveur » et choisissez « Déconnexion » (Figure 26)

Fichier Edition Affichage Transfert [Serveur] Favoris 7
el v| | = - ::| ﬂ ‘“‘a Annuler I'opération en cours Ctrl+.
Héte: Identifiant : Recennexion Ctrl+R

: - De [ Ctrl+D
Statut: Déconnecte du serveu S - h
Statut: Connexon 3 SINPapp=3 Recherche de fichiers distants... F3
Statut : Connected to sinpapp
Statut : Récupération du conte Saisir une commande personnalisée...
statut: Listing d|rect|:|r}r,'_‘ o Forcer I'affichage des fichiers cachés
Statut: Contenu du dossier "/

Figure 26




